Thank you for purchasing OKI Multifunctional Digital Systems or Multifunctional Digital Color Systems. This manual explains the instructions for the Fax driver. Read this manual before using your Multifunctional Digital Systems or Multifunctional Digital Color Systems. Keep this manual within easy reach, and use it to configure an environment that makes best use of the OKI MFP’s functions.

To use this function, the scanning function (Internet Fax) and printing function (Network Fax) are required.

How to read this manual

Symbols in this manual

In this manual, some important items are described with the symbols shown below. Be sure to read these items before using this equipment.

⚠️ WARNING  Indicates a potentially hazardous situation which, if not avoided, could result in death, serious injury, or serious damage, or fire in the equipment or surrounding objects.

⚠️ CAUTION   Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury, partial damage to the equipment or surrounding objects, or loss of data.

Note       Indicates information to which you should pay attention when operating the equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with the following signage:

Tip       Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.

Screens and Operation Procedures

• In this manual, the screens and the operation procedures in Windows are described for Windows 7. The details on the screens may differ depending on how the equipment is used, such as the status of the installed options, the OS version and the applications.
• If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens or the menu names, etc. may differ.
• The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the display or the order of buttons in the illustrations may differ from that of your equipment.
• In this manual, the initial values of the setting items are underlined.
Trademarks

- The official name of Windows XP is Microsoft Windows XP Operating System.
- The official name of Windows Vista is Microsoft Windows Vista Operating System.
- The official name of Windows 7 is Microsoft Windows 7 Operating System.
- The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
- The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
- Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are trademarks of Microsoft Corporation in the US and other countries.
- Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other countries.
- Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- Mozilla, Firefox and the Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and other countries.
- IBM, AT and AIX are trademarks of International Business Machines Corporation.
- NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
- Other company and product names given in this manual or displayed in this software may be the trademarks of their respective companies.
CONTENTS

Preface........................................................................................................................................... 1

Chapter 1  OVERVIEW

Features and Functions ................................................................................................................ 6

Chapter 2  SENDING A FAX

Basic Procedure ........................................................................................................................ 8

Specifying Recipients .............................................................................................................. 12
Entering recipients from the keyboard ...................................................................................... 12
Selecting recipients from the address book ............................................................................ 14
Selecting recipients from the address book (Search option) ...................................................... 16
Removing recipients ................................................................................................................ 20

Chapter 3  SETTING OPTIONS

How To Setup .......................................................................................................................... 22
Setting Initial Values of the Fax driver options ...................................................................... 22
Setting print options for each print job ................................................................................... 22

Setting up the Fax Driver Options ......................................................................................... 23
Setting up the [Layout] tab ...................................................................................................... 23
Setting up the [Send] tab ......................................................................................................... 24
Setting up the Cover Sheet ..................................................................................................... 26
Setting up the SNMP ............................................................................................................... 27
Setting up the [Device Settings] tab ....................................................................................... 29
Setting up LDAP servers ........................................................................................................ 30

Sending With Extended Fax Functionality ........................................................................... 31
Saving a fax as a file ................................................................................................................ 31
Delayed transmission ............................................................................................................... 32
Sending with a cover sheet ...................................................................................................... 33

Chapter 4  APPENDIX

Cover Sheet Samples ............................................................................................................... 40
Standard cover page ............................................................................................................... 40
Business cover page .............................................................................................................. 41
Professional cover page ......................................................................................................... 42

INDEX ........................................................................................................................................... 43
This chapter provides an overview of the Network Fax features.

Features and Functions

6
Features and Functions

This equipment provides the network fax features, which simplify and facilitate your office facsimile needs and enables you to send fax or Internet Fax digital documents directly from your desktop.

**Notes**

- Fax transmission using the Fax driver is available only when the optional Fax unit is installed.
- Please enable the SNMP setting on TopAccess to use the Fax functions. In addition, the Fax driver does not work if the SNMP setting on TopAccess is disabled when the optional Fax unit is installed.

The highly intuitive, network Fax driver software enables you to select the fax printer driver to electronically fax or Internet Fax from your computer to one or more recipients. You can easily define fax job properties from the send list to fax resolutions. The Fax driver is complimented with the AddressBook Viewer. The combination of applications enables you easily to manage a selection of fax recipients and access to the address book.

The Fax driver enables you to set up send lists and send electronic documents from your PC to one or more destinations. You send to the fax in much the same way you would choose to print to a designated printer that makes using the Fax driver quick and simple. You can select the fax properties. Fax properties are the attributes you can set to define sender and recipient information for processing fax jobs such as dialing options, sender information, fax resolution and page layout.

Other features include an easy-to-use fax scheduler that allows you to set up a date and time to transmit your fax. Cover page options are also provided. You can include a customized cover page with your fax transmission that can contain sender and recipient fax information and a detailed message. You can easily maintain sender and contact information that can be printed on the cover pages.

**Note**

Faxing hard-copy documents must be performed from the touch panel display.

**Tips**

- The image quality of the originals that are sent by the Fax driver is different from the originals that are sent by the general fax operation.
- If you specify the Email addresses as the recipients using the Fax driver, the document will be sent as an Internet Fax. The Internet Fax feature allows users to send originals the same as the fax features. However, an Internet Fax is sent through the Internet, although a fax is sent through the public switched telephone line. In order to send an Internet Fax, the remote device also must support the Internet Fax feature.

For more details about the Internet Fax, refer to the *Scanning Guide*. 

---

*OVERVIEW*

6 Features and Functions
SENDING A FAX

This chapter describes how to send a fax using a Fax driver.

**Basic Procedure** ................................................................................................................................. 8

**Specifying Recipients** ......................................................................................................................... 12
- Entering recipients from the keyboard .................................................................................................. 12
- Selecting recipients from the address book ......................................................................................... 14
- Selecting recipients from the address book (Search option) ............................................................... 16
- Removing recipients ............................................................................................................................. 20
Basic Procedure

The basic procedure for sending a fax (Network Fax / Internet Fax) is as follows. You can use standard functions or set optional functions as well as the basic ones described in this section. For these operations, see the following section.

P.21 “SETTING OPTIONS”

1 Start the application software and prepare the document to be sent.

2 Select [Print] from the [File] menu in the application software.

   Tip

   The procedure for displaying the print dialog box may differ from the above depending on the application software.

3 Select [OKI MFP Fax] for the printer and click [Preferences].

   The dialog box of the Fax driver properties appears.

   Tip

   Note that the command name to open the driver properties may differ from [Preferences] depending on the application software.
4 Click the [Send] tab and specify the recipients.

- To specify recipients, enter them with the keyboard or select them from the address book. [P.12 “Specifying Recipients”]
- On the [Send] tab, you can set the resolution of a fax cover sheet, etc. as well as specifying the recipients. [P.24 “Setting up the [Send] tab”]
- On the [Layout] tab, you can set the size and the orientation of the paper. [P.23 “Setting up the [Layout] tab”]
- On the [Cover Sheet] and [Sender Information Properties] tab, the sender information for adding a fax cover sheet can be set. [P.26 “Setting up the Cover Sheet”  P.27 “Setting up the SNMP”]

5 Click [OK].

The transmission settings are determined and the Fax driver properties dialog box is closed.
6 Click [Print] in the print dialog box on the application software.

A fax starts being sent.

**Tips**

- Note that the command name to print a document (send a fax) may differ from [Print] depending on the application software.
- A waiting fax job can be checked or deleted through the managing jobs function in TopAccess. A sent fax job can also be checked through the displaying job logs function in TopAccess. For details, refer to the TopAccess Guide.

**Cautionary points when LDAP authentication is used**

When LDAP authentication is enabled on this equipment, you must specify an LDAP server in the [Server Name] box on the [Send] tab before sending a fax.

If you attempt to send a fax without specifying an LDAP server, the [Specify LDAP Server] dialog box will appear to ask you to do so.
In this case, specify the desired LDAP server in the [Server Name] box and click [OK] to send the fax.

You can make settings for LDAP authentication on the [Device Settings] tab. 
P.29 “Setting up the [Device Settings] tab”
Specifying Recipients

Up to 400 recipients can be specified in a single operation. To send a Network Fax, specify the fax number. To send an Internet Fax, specify the Email address.

P.12 “Entering recipients from the keyboard”
P.14 “Selecting recipients from the address book”
P.16 “Selecting recipients from the address book (Search option)”
P.20 “Removing recipients”

Tip

To use the address book, you need to register recipients in the address book of AddressBook Viewer in advance.

Note

If more than one recipient is specified in a single transmission, and a cover sheet is set in the Fax driver or a header page is set to be printed on the recipient's device, all the recipient information may be printed. If you want to secure the recipient information, avoid sending a fax to multiple recipients at the same time.

■ Entering recipients from the keyboard

You can enter a recipient with the keyboard.

1 For the recipient of a Network Fax, click [Fax Number] and enter the fax number in the right-hand box. For one of an Internet Fax, click [Internet Fax Address] and enter the Email address in the right-hand box.
When you enter a fax number, you can also enter a sub address and a password. Click [SUB/PWD] to enter them (within 20 digits each) in the dialog box. Entering them enables the document to be transferred from the recipient’s device to that of the sub-address, as the communication is in compliance with ITU-T standard. However, in order to use this function, the recipient’s device must be a model in compliance with the ITU-T standard.

- Use “ - ” (hyphen) if you send a Network Fax with pauses (approx. 3 seconds) inserted in the fax number.

2 Click .

The recipients selected for “To” are listed.

Tip

When the fax transmission is completed, the recipients are automatically removed from the “To” list.
Selecting recipients from the address book

Select a recipient from the address book in the AddressBook Viewer.

1. Click [Address Book].

   ![AddressBook Viewer]

   The AddressBook Viewer runs.

2. When selecting a fax number after selecting a contact from the contact list, click [Select Fax] and when selecting an Email address, click [Select Email].

   ![AddressBook Viewer Select Fax and Email]

   The selected recipients are listed in the “Selected Fax” or “Selected Email”.
2. SENDING A FAX

Specifying Recipients

A contact, for which only a fax number is registered, cannot be displayed in the “Selected Email” and a contact, for which only an Email address is registered, cannot be displayed in the “Selected Fax”.

You can select a recipient by the following operations:

**Selecting a contact by dragging and dropping**
Drag a contact in the contact list and drop it to the “Selected Fax” or “Selected Email”.

**Selecting a contact by double-clicking on it**
Double-click on a contact in the contact list. To change the setting of the recipient to be selected upon double-clicking, select [Default Configuration], [Type Selection] in the [View] menu and then one of [Fax], [Email] and [Both].

**Selecting a contact from a shortcut menu**
Right-click on the contact in the contact list, select [Select] from the shortcut menu and then either [Fax Number] and [Email].

**Removing a recipient**
Select a recipient in the “Selected Fax” or “Selected Email” and click the corresponding [Remove] (Left: fax number, Right: Email address).

3. Click [OK].

The AddressBook Viewer is closed and the recipients selected for “To” are listed.

**Tip**
When the fax transmission is completed, the recipients are automatically removed from the “To” list.
Selecting recipients from the address book (Search option)

You can find and select a recipient from the address book in the AddressBook Viewer.

1. Click [Address Book].

The AddressBook Viewer runs.


The [Find Contact] dialog box appears.
3 Select a registered directory service in [Data Source].

To change the setting of the default address book in the [Data Source] box, select [View] - [Default Configuration] - [Data Source] and then choose an address book.

4 Display the [Person] tab and enter search strings in the following boxes.

- **Display Name** — To search display names, enter a search string here.
- **Fax Number** — To search fax numbers, enter the numbers here.
- **Email** — To search Email addresses, enter a search string here.

If you perform searching in the above conditions, proceed to step 6. If you want to set more detailed search conditions, proceed to step 5 and set the [Detail Setting] tab. Note that even if you enter the search conditions in both the [Person] and [Detail Setting] tabs, you cannot perform searching in this combination.

Tip

In the [Person] tab, you do not have to fill in all the boxes and the string does not need to completely correspond to the target of the search. Entering one or more characters in one or more boxes causes a search to be made for contacts which correspond to the particular conditions.
5 Display the [Detail Setting] tab, set the search condition, and then click [Add].

Field Select — Select an item to be searched.
Condition of search string — Select a condition in the left-hand box, and then enter a search string in the right-hand box.

- The search condition is displayed in the “Condition list”.
- To set more than one search condition, repeat this operation as many times as needed.
- To delete the search conditions, select one and click [Remove].

6 Click [Search].

- It starts searching contacts in the selected address book. When the search is complete, the contacts matching the search conditions are listed.
- To stop searching, click [Stop].

**Note**

Even if you enter the search conditions in both the [Person] and [Detail Setting] tabs, only the search condition in the tab currently displayed is used. You cannot perform searching in the combined conditions on both tabs.
7 Drag and drop the contacts to “Selected Fax” or “Selected Email” from the list of the search results.

The selected recipients are listed in “Selected Fax” or “Selected Email”.

**Note**

A contact, for which only a fax number is registered, cannot be displayed in the “Selected Email” and a contact, for which only an Email address is registered, cannot be displayed in the “Selected Fax”.

You can select a recipient by the following operations:

**Selecting a contact by double-clicking on it**
Double-click on a contact in the list of the search results. To change the setting of the recipient to be selected upon double-clicking, select [Default Configuration], [Type Selection] in the [View] menu and then one of [Fax], [Email] and [Both].

**Selecting a contact from a shortcut menu**
Right-click on the contact in the list of the search results, select [Select] from the shortcut menu and then either [Fax Number] or [Email].

**Removing a recipient**
Select a recipient in the “Selected Fax” or “Selected Email” and click the corresponding [Remove] (Left: fax number, Right: Email address).
Click [OK].

The AddressBook Viewer is closed and the recipients selected for "To" are displayed on the list.

**Tip**

When the fax transmission is completed, the recipients are automatically removed from the "To" list.

### Removing recipients

You can remove a recipient from the "To" list in the Fax driver properties.

1. Select a recipient and click [Remove].

The selected recipient is removed.
This chapter describes how to set up options for the Fax driver.

How To Setup.......................................................................................................................... 22
  Setting Initial Values of the Fax driver options................................................................. 22
  Setting print options for each print job........................................................................... 22

Setting up the Fax Driver Options .................................................................................. 23
  Setting up the [Send] tab................................................................................................. 24
  Setting up the Cover Sheet............................................................................................. 26
  Setting up the SNMP....................................................................................................... 27
  Setting up the [Device Settings] tab............................................................................... 29
  Setting up LDAP servers............................................................................................... 30

Sending With Extended Fax Functionality........................................................................ 31
  Saving a fax as a file........................................................................................................ 31
  Delayed transmission...................................................................................................... 32
  Sending with a cover sheet............................................................................................. 33
How To Setup

There are two ways to set the Fax driver options: One is to set the initial values of the options and the other is to set each option for each individual job.

P.22 “Setting Initial Values of the Fax driver options”
P.22 “Setting print options for each print job”

Setting Initial Values of the Fax driver options

Setting the Fax options by displaying the Fax driver properties from the Printers folder on the Windows [Start] menu will establish the initial values of the options.

1 Click the Start button and then select [Devices and Printers].
   When using Windows XP / Windows Server 2003, click [Start] and select [Printers and Faxes].
   When using Windows Vista / Windows Server 2008, click [Start] and select [Control Panel], [Hardware and Sound] and then [Printers].

2 Right-click [OKI MFP Fax], and then select [Printing preferences] or [Printer properties] from a shortcut menu.
   - If [File] menu is not displayed, press [Alt].

Setting print options for each print job

Setting the Fax driver options by displaying the printer properties from the Print dialog box within an application will establish the values for the current Fax job. The Fax driver option settings specific to each Fax job are set using this method.

1 Click the [File] menu and select [Print] on an application.

2 Select [OKI MFP Fax] and click [Properties] or [Preferences].
Setting up the Fax Driver Options

Fax driver options are the attributes to define the way a fax job is transmitted. For example, you can specify the recipients, resolution, and paper size.

- P.23 “Setting up the [Layout] tab”
- P.24 “Setting up the [Send] tab”
- P.26 “Setting up the Cover Sheet”
- P.27 “Setting up the SNMP”
- P.29 “Setting up the [Device Settings] tab”
- P.30 “Setting up LDAP servers”

■ Setting up the [Layout] tab

On the [Layout] tab, you can set the size and the orientation of the paper.

1) Orientation
   Set the printing orientation of the document.
   - Portrait — Data are printed vertically to the paper.
   - Landscape — Data are printed horizontally to the paper.

2) [Advanced]
   Click this to display the [Advanced Option] dialog box. You can select the paper size of the document.
Setting up the [Send] tab

In the [Send] tab, you can specify the recipients and how the fax will be sent.

1) [Address Book]
Click to launch the AddressBook Viewer. You can select recipients from the address book.
P.14 “Selecting recipients from the address book”

2) [To]
This displays the specified recipients list.
P.12 “Specifying Recipients”

3) [Remove]
Select a recipient in the [To] list and click this to remove the recipient from the list.
P.20 “Removing recipients”

4) Fax Number
Enter the recipient’s fax number directly.
P.12 “Entering recipients from the keyboard”

5) [SUB/PWD]
Click this to display the [SUB/PWD] dialog box. You can add a sub address and a password to the entered fax number.
P.12 “Entering recipients from the keyboard”

6) Internet Fax Address
Enter the recipient’s Internet Fax number directly.
P.12 “Entering recipients from the keyboard”

7) Resolution
Select the resolution for the fax.
- **Standard (200 x 100 dpi)** — Select this to send a document in Standard mode (200 x 100 dpi).
- **Fine (200 x 200 dpi)** — Select this to send a document in Fine mode (200 x 200 dpi).
- **Super Fine (200 x 400 dpi)** — Select this to send a document in Super Fine mode (200 x 400 dpi).
- **Ultra Fine (400 x 400 dpi)** — Select this to send a document in Ultra Fine mode (400 x 400 dpi).
8) Department Code
Enter a department code of 1 to 63 characters if required. When the department code is enabled on this equipment, you must enter it to send a fax.

Notes
- If you do not enter a department code when it is enabled on the equipment and the Invalid Department Code Print Job is set to “Store to invalid job list” in TopAccess, the job will be stored in the Invalid job list without being transmitted. You can print or delete a stored job from the [JOB STATUS] on the touch panel. For instructions on how to print or delete a job in the Invalid job list, refer to the Printing Guide.
- If you do not enter the department code when the department code is enabled on the equipment and the Invalid Department Code Print Job is set to PRINT in TopAccess, the job will be sent.
- If you do not enter the department code when the department code is enabled on the equipment and the Invalid Department Code Print Job is set to DELETE in TopAccess, the job will be deleted automatically.

9) Hide Department Code
Select this check box to display a department code in the blank symbols.

10) Cover Sheet
Select a cover sheet type among [Standard Cover Page], [Business Cover Page] and [Professional Cover Page] if you want to attach a cover sheet to the first page of the document.
[ P.33 “Sending with a cover sheet”
[ P.40 “Cover Sheet Samples”

11) [Edit]
Click this to display the [Cover Sheet Settings] dialog box. You can perform various kinds of editing on the cover sheet selected in the Cover Sheet setting, such as entering a subject or a message, or changing the type or size of the fonts.
[ P.26 “Setting up the Cover Sheet”

12) Server Name
Select the desired LDAP server in the [Server Name] box if needed.

Tip
You can make settings for the LDAP server on the [Device Settings] tab.
[ P.29 “Setting up the [Device Settings] tab”

13) [SNMP Settings]
Click this to check or change the SNMP settings.
[ P.27 “Setting up the SNMP”

14) Delayed Fax
Select this to send a document on a specified date and time. When this is selected, click [Edit] to display the [Scheduled Time] dialog box and specify date and time the job will be transmitted. The job sent to this equipment will be stored in the Fax queue until the specified date and time.
[ P.32 “Delayed transmission”

15) Save as File
Select this to save up to 10 GB of documents in the “FILE_SHARE” folder in the equipment as well as send the document as a fax and Internet Fax.
[ P.31 “Saving a fax as a file”

Tip
When the cover sheet is set, the cover sheet and the original will be stored in the “FILE_SHARE” folder.

16) File Format
Select the file format of the document that will be saved. This option can be selected only when the [Save as File] check box is selected.

17) [Restore Defaults]
Click this to restore the default setting values.

18) [Help]
Click this to browse Help for the Fax driver.
Setting up the Cover Sheet

You can set the content of the cover sheet to be attached to a fax.

1) Preview
The image of the cover sheet can be previewed. You can check the layout of the character strings and images.

Notes

- Depending on the line feed positions, the preview may not duplicate the actual print result of the cover sheet, but is used for checking its layout.
- If the contents are on more than one page, such as the many line feeds included in “Sender Information” or “Message”, only the first one page is displayed in the preview.

2) Fonts
Select the font to be used for the cover sheet. Select the section for which the font is used, and then click [Edit] to select the type, style and size of the font.
   - Header — Set the font to be used for the header of the cover sheet.
   - Title — Set the font to be used for the title such as Reference Number, Recipients Information, Sender Information, Subject or Message.
   - Body — Set the font to be used for the body of each title.

3) Footer
Select an image file to be attached to the footer of the cover sheet.
   - [Browse] — Click this to select an image file to be attached to the footer within 1 MB.
   - [Delete] — Click this to delete the attached image file.
   - Position — Select the position of the image file from the left, center and right.

4) Header Text
Enter a title to be displayed on the header of the cover sheet; it can be up to 63 characters.

5) Reference Number
Check this to have a reference number identifying the fax to appear on the cover sheet. Enter the reference number in the text box.

6) Recipient’s Information
Check this to have the recipient’s information appear on the cover sheet. Select the desired information among the options below.
   - Name — Check this to have the recipient name appear on the cover sheet.
   - Company — Check this to have the recipient company name appear on the cover sheet.
   - Department Name — Check this to have the recipient department name appear on the cover sheet.
   - Fax Number — Check this to have the recipient fax number or Email address appear on the cover sheet.
7) **Sender Information**
   Check this to have the sender’s information appear on the cover sheet. You can enter the information in up to 500 characters.

8) **Subject**
   Check this to have a subject appear on the cover sheet. You can enter the subject in up to 40 characters.

9) **Message**
   Check this to have a message appear on the cover sheet. You can enter the message in up to 500 characters.

10) **[Restore Defaults]**
    Click this to restore the default setting values.

### Setting up the SNMP

If the recipient’s OKI MFP is not found over the Internet and the fax job is not sent normally, the SNMP settings may be the cause. Check that the SNMP settings are correct in the [SNMP Settings] dialog box, and if not, change them.

**Note**

Ask the administrator for details on the SNMP Network settings configured for your OKI MFP.

1) **Version**
   Be sure to have the correct SNMP version set for your OKI MFP and select from the following options:
   - **V1/V2** — Select this option to enable SNMP V1 and V2.
   - **V3** — Select this option to enable SNMP V3.
   - **V1/V2/V3 (for [Discovery Settings] dialog box only)** — Select this option to enable SNMP V1, V2, and V3.
2) **SNMP V1/V2**

Community Name — If a community name other than “private” (default) is set for the SNMP community name for your OKI MFP, enter its community name.

**Notes**

- To send fax jobs normally under an SNMP V1/V2 environment, the SNMP community names must be the same in the 3 settings shown below. For help, ask your administrator.
  - Your OKI MFP
  - [SNMP Settings] dialog box of the [Sender Information] tab
  - TCP/IP port of the [Ports] tab in the Fax driver

- To change the community name, the administrator privilege is necessary. You must log in with the “Administrator” privilege and open the printer driver properties.
- Up to 31 characters including the following symbols can be entered for the Community Name.

```
! # $ % & ' ( ) * + , / : ; < = > ? @ [ \ ] ^ _ ` { | } ~
```

3) **SNMP V3**

If SNMP V3 is enabled, select one of the following items to set how users are authenticated.

- **User ID File** — Select this option when you want to use a user ID file. Click [Browse] and specify the user ID file.
- **User Name/Password** — Select this option when you want to use the user name and password. When this option is selected, keyboard or select the following items:
  - **User Name**
  - **Authentication Protocol**
  - **Authentication Password**
  - **Privacy Protocol**
  - **Privacy Password**

**Notes**

- If you select to enable SNMP V3, consult your network administrator for preliminary advice on how to authenticate users.
- Up to 31 characters including the following symbols can be entered for each of the User Name, Authentication Password and Privacy Password.

```
! $ % & ' ( ) - , < > @ [ \ ] ^ _ ` { | } ~
```

4) **[Restore Default]**

Click this button when you want to reset all the settings back to the defaults.
Setting up the [Device Settings] tab

On the [Device Settings] tab, you can change a setting for Fax driver update or display the software version of the driver.

Note

Ask the administrator for details on the settings configured for your OKI MFP.

1) Update Automatically
   Select whether or not the setting information of each item on the [Device Settings] tab of the Fax driver is to be obtained by automatically communicating with your OKI MFP every time this tab is opened.
   - On — Select this to obtain the setting information automatically.
   - Off — Select this not to obtain the setting information automatically. Set each item manually.

2) User Authentication
   Select the authentication method which is to be used. Set it to correspond to that of your OKI MFP.
   - On — Select this not to perform user authentication.
   - MFP Local Authentication — Select this to perform MFP Local Authentication.
   - Windows Domain Authentication — Select this to perform Windows Domain Authentication.
   - LDAP Authentication — Select this to perform LDAP Authentication.

3) [Details]
   When you click this button, the [LDAP Server Settings] dialog box will appear. This option can be selected only when [LDAP Authentication] is selected in the [User Authentication] box.
   ® P.30 “Setting up LDAP servers”

4) Fax Function
   Select whether or not the fax function is enabled. Set it to correspond to that of your OKI MFP.
   - Enabled — Select this to enable the fax function.
   - Disabled — Select this to disable the fax function.

5) Internet Fax Function
   Select whether or not the Internet Fax function is enabled. Set it to correspond to that of your OKI MFP.
   - Enabled — Select this to enable the Internet Fax function.
   - Disabled — Select this to disable the Internet Fax function.

6) [Version Information]
   Click this to display the software version information of the Fax driver.
### Setting up LDAP servers

The [LDAP Server Settings] dialog box allows you to register LDAP servers.

1) **[Update Now]**
   Click this button to obtain LDAP server information automatically from your OKI MFP, and register it in [Server Name List].

2) **Server Name**
   Enter the desired LDAP server in this box if needed.
   
   **Tip**
   
   Up to 64 characters (excluding # ; \ =) can be entered for the [Server Name] box.

3) **[Add]**
   Click this button to register the LDAP server in the [Server Name List], which has been entered in the [Server Name] box.

4) **Server Name List**
   The registered LDAP servers are displayed in this list. Up to 8 LDAP servers can be registered.

5) **[Delete]**
   Click this button to delete an LDAP server in [Server Name List]. Select the LDAP server that you want to delete in the list, and click this button.
Sending With Extended Fax Functionality

The Fax driver allows users to perform the following features:
- P.31 “Saving a fax as a file”
- P.32 “Delayed transmission”
- P.33 “Sending with a cover sheet”

**Saving a fax as a file**

You can save a document in the “TXFAX” folder in the “FILE_SHARE” folder in this equipment as well as sending the document to fax numbers and Email addresses.

1. Display the [Send] tab and select the [Save as File] check box.

2. Select the file format in the [File Format] box.

3. Specify the other options to send a document and click [OK].

4. Click [OK] (or [Print]) to send a document to this equipment.

   The document is saved in the “TXFAX” folder in the “FILE_SHARE” folder in this equipment.

**Tips**

- The saved file contains the cover sheet when the cover sheet is set.
- Since the image smoothing function does not work for the image stored in the “FILE_SHARE” folder, its printing image quality differs from the normal fax image quality.
**3 SETTING OPTIONS**

**Sending With Extended Fax Functionality**

- **Delayed transmission**
  When the delayed transmission is specified, the fax is stored in the fax queue in this equipment and will be sent at the specified date and time.

  1. Display the [Send] tab and select the [Delayed Fax] check box.

  ![Image of sending settings](Image)

  2. Click [Edit].
   The [Scheduled Time] dialog box appears.

  3. Select the date and time and click [OK].

    ![Image of scheduled time](Image)

    - You can click the Date arrow to display a calendar that allows you to select a date.
    - Enter the time to commence the fax transmission. You can use the up and down arrows to assist with setting the time in the proper format.

    **Note**
    The scheduled date cannot be more than one month from the current date. If the current month does not have a date like the current one, then the date will be set at the last day of the following month. For example, if the current date is March 31st, then the maximum date that can be selected for the scheduled fax is April 30th.

  4. Specify the other options to send a document and click [OK].

  5. Click [OK] (or [Print]) to send a document to this equipment.
3. SETTING OPTIONS

### Sending with a cover sheet

You can choose to send a cover sheet with your fax transmission. The cover sheet is merged with the recipient [To] list data to create a fax cover sheet. You can select what to include on the cover sheet such as sender or recipient information.

#### Note

When a printer driver whose name consists of 54 letters or more is specified for the default printer and an attempt is made to send a fax with a cover sheet added from Microsoft Excel using a Fax driver with an IPP port, an XL error may occur and fax transmission may be impossible. (This error does not occur in application software other than Microsoft Excel.)

If this error occurs, perform one of the following and start sending a fax again.
- Use 30 letters or less for the Fax driver name.
- Do not attach any cover sheet.

1. Display the [Send] tab, select the cover sheet type in the [Cover Sheet] box and then click [Edit].

![Cover Sheet Settings dialog box](image)

The [Cover Sheet Settings] dialog box appears.
2 Enter the title of the cover sheet in the [Header Text] box.

You can enter up to 63 characters for the header text.

3 If you want a reference number identifying the document to appear on the cover sheet, select the [Reference Number] check box and then enter the reference number in the text box.

You can enter up to 20 characters for the reference number.
4. If you want the recipient’s information to appear on the cover sheet, select the [Recipient Information] check box and then select the options required for the recipient information.

Name — Check this to have the name of the recipient appear on the cover sheet.
Company — Check this to have the company name of the recipient appear on the cover sheet.
Department Name — Check this to have the department name of the recipient appear on the cover sheet.
Fax Number — Check this to have the fax number or Email address of the recipient appear on the cover sheet.

Notes

- Recipient information is obtained from the address book. If the recipient is added manually, this information does not appear on the cover sheet except for the fax number or Email address.
- The recipient information for all recipients will appear on the cover sheet.

5. If you want sender information to appear on the cover sheet, select the [Sender Information] check box and then enter the sender information in the text box.

You can enter up to 500 characters for the sender information.
6 If you want a subject to appear on the cover sheet, select the [Subject] check box and then enter the subject in the text box.

You can enter up to 40 characters for the subject.

7 If you want a message to appear on the cover sheet, select the [Message] check box and then enter the message in the text box.

You can enter up to 500 characters for the message.

8 If you want to change the font of the characters on the cover sheet, select the corresponding section in the [Font for] box, and then click [Edit].

The [Font] dialog box appears.

If you do not change the font, proceed to step 10.
9 Select the desired one from each of the [Font], [Font style], [Size] and [Script] boxes, and then click [OK].

The [Font] dialog box is closed and the font settings are determined for the selected section.

Tip
If you want to change the font of other sections, repeat the procedure from step 8.

10 If you want to attach an image file on the footer, click [Browse] of Image File.

The [Open] dialog box appears.

If you do not attach an image file, proceed to step 13.
11 Select an image file to be attached and then click [Open].

![Image of Open dialog box]

The [Open] dialog box is closed and the selected image file is attached.

**Note**

Attach the image file in a bitmap format (.bmp) within 1 MB.

12 Select the position of the image file.

![Image of Cover Sheet Settings]

- Select this to align the image to the left.
- Select this to align the image to the center.
- Select this to align the image to the right.

13 Specify the other options to send a document and click [OK].

14 Click [Print] to send a document to this equipment.
APPENDIX

This chapter shows the cover sheet samples.

Cover Sheet Samples............................................................................................................. 40
  Standard cover page ........................................................................................................... 40
  Business cover page ......................................................................................................... 41
  Professional cover page .................................................................................................. 42
Cover Sheet Samples

- Standard cover page

**FACSIMILE TRANSMITTAL**

Reference Number:
0000000000000000

To:
00000000001

From:
XXX-xxxxxxxx

Subject:
Fax Document

Message:
This is a Fax Document.
Business cover page

FACSIMILE TRANSMITTAL SHEET

Reference Number:
0000000000000000

To:
00000000001

From:
XXX-xxxxxxxxx

Subject:
Fax Document

Message:
This is a Fax Document.
Professional cover page

---

**FACSIMILE TRANSMITTAL SHEET**

Reference Number: 0000000000000000
To: 00000000001
From: XXX-xxxxxxx
Subject: Fax Document
Message: This is a Fax Document.
## INDEX

<table>
<thead>
<tr>
<th>A</th>
<th>Add ......................................................................30</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Address Book ....................................................14, 16, 24</td>
</tr>
<tr>
<td></td>
<td>AddressBook Viewer ..............................................14, 16</td>
</tr>
<tr>
<td></td>
<td>Advanced ..................................................................23</td>
</tr>
<tr>
<td>B</td>
<td>Basic procedure ....................................................8</td>
</tr>
<tr>
<td></td>
<td>Business cover page ..............................................41</td>
</tr>
<tr>
<td>C</td>
<td>Community Name ..................................................28</td>
</tr>
<tr>
<td></td>
<td>Cover Sheet ..........................................................25, 26</td>
</tr>
<tr>
<td>D</td>
<td>Delayed Fax .........................................................25, 32</td>
</tr>
<tr>
<td></td>
<td>Delete ........................................................................30</td>
</tr>
<tr>
<td></td>
<td>Department Code ..................................................25</td>
</tr>
<tr>
<td></td>
<td>Details ........................................................................29</td>
</tr>
<tr>
<td></td>
<td>[Device Settings] tab ..............................................29</td>
</tr>
<tr>
<td>E</td>
<td>Edit .........................................................................25</td>
</tr>
<tr>
<td>F</td>
<td>Fax driver options ..................................................23</td>
</tr>
<tr>
<td></td>
<td>Fax Function ..........................................................29</td>
</tr>
<tr>
<td></td>
<td>Fax Number ................................................................24</td>
</tr>
<tr>
<td></td>
<td>File Format .............................................................25, 31</td>
</tr>
<tr>
<td></td>
<td>Fonts ..........................................................................26</td>
</tr>
<tr>
<td></td>
<td>Footer ........................................................................26</td>
</tr>
<tr>
<td>H</td>
<td>Header Text .............................................................26</td>
</tr>
<tr>
<td></td>
<td>Help ..........................................................................25</td>
</tr>
<tr>
<td></td>
<td>Hide Department Code .............................................25</td>
</tr>
<tr>
<td>I</td>
<td>Initial values ..........................................................22</td>
</tr>
<tr>
<td></td>
<td>Internet Fax Address ................................................24</td>
</tr>
<tr>
<td></td>
<td>Internet Fax Function .............................................29</td>
</tr>
<tr>
<td>L</td>
<td>[Layout] tab .............................................................23</td>
</tr>
<tr>
<td>M</td>
<td>Message ......................................................................27</td>
</tr>
<tr>
<td>O</td>
<td>Orientation ................................................................23</td>
</tr>
<tr>
<td>P</td>
<td>Preview .....................................................................26</td>
</tr>
<tr>
<td></td>
<td>Professional cover page .......................................42</td>
</tr>
<tr>
<td></td>
<td>PWD ..........................................................................13</td>
</tr>
<tr>
<td>R</td>
<td>Recipient’s Information ..........................................26</td>
</tr>
<tr>
<td></td>
<td>Reference Number ..................................................26</td>
</tr>
<tr>
<td></td>
<td>Remove .......................................................................24</td>
</tr>
<tr>
<td></td>
<td>Removing recipients ................................................20</td>
</tr>
<tr>
<td></td>
<td>Resolution ...................................................................24</td>
</tr>
<tr>
<td></td>
<td>Restore Defaults ....................................................25, 27, 28</td>
</tr>
<tr>
<td>S</td>
<td>Save as File ..............................................................25, 31</td>
</tr>
<tr>
<td></td>
<td>[Send] tab .................................................................24</td>
</tr>
<tr>
<td></td>
<td>Sender Information ...................................................27</td>
</tr>
<tr>
<td></td>
<td>Server Name ............................................................25, 30</td>
</tr>
<tr>
<td></td>
<td>Server Name List ......................................................30</td>
</tr>
<tr>
<td></td>
<td>SNMP Settings ..........................................................25, 27</td>
</tr>
<tr>
<td></td>
<td>SNMP V1/V2 ..............................................................28</td>
</tr>
<tr>
<td></td>
<td>SNMP V3 ...................................................................26</td>
</tr>
<tr>
<td></td>
<td>Specifying recipients ...............................................12</td>
</tr>
<tr>
<td></td>
<td>Standard cover page ...............................................40</td>
</tr>
<tr>
<td></td>
<td>SUB ..........................................................................13</td>
</tr>
<tr>
<td></td>
<td>SUB/PWD ..................................................................24</td>
</tr>
<tr>
<td></td>
<td>Subject .......................................................................27</td>
</tr>
<tr>
<td>T</td>
<td>To (recipient) ............................................................24</td>
</tr>
<tr>
<td>U</td>
<td>Update Automatically ...............................................29</td>
</tr>
<tr>
<td></td>
<td>Update Now ..............................................................30</td>
</tr>
<tr>
<td></td>
<td>User Authentication ...................................................29</td>
</tr>
<tr>
<td>V</td>
<td>Version .....................................................................29</td>
</tr>
<tr>
<td></td>
<td>Fax driver ..............................................................29</td>
</tr>
<tr>
<td></td>
<td>SNMP .........................................................................27</td>
</tr>
</tbody>
</table>